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Welcome

This guide describes publishing ArchestrA Symbols and InTouch 
Windows to the web using the ArchestrA Web Exporter. This utility 
can be downloaded from the Information Server portal and installed 
on a computer as an extension of the ArchestrA Integrated 
Development Environment (IDE).

You can view this document online or you can print it, in part or whole, 
by using the print feature in Adobe Acrobat Reader.

This guide assumes you know how to use Microsoft Windows, 
including navigating menus, moving from application to application, 
and moving objects on the screen. If you need help with these tasks, 
see the Microsoft online help. 

Documentation Conventions 

This documentation uses the following conventions:

Convention Used for

Initial Capitals Paths and file names.

Bold Menus, commands, dialog box names, 
and dialog box options.

Monospace Code samples and display text.
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Technical Support
Wonderware Technical Support offers a variety of support options to 
answer any questions on Wonderware products and their 
implementation.

Before you contact Technical Support, refer to the relevant section(s) 
in this documentation for a possible solution to the problem. If you 
need to contact technical support for help, have the following 
information ready:

• The type and version of the operating system you are using.

• Details of how to recreate the problem.

• The exact wording of the error messages you saw.

• Any relevant output listing from the Log Viewer or any other 
diagnostic applications.

• Details of what you did to try to solve the problem(s) and your 
results.

• If known, the Wonderware Technical Support case number 
assigned to your problem, if this is an ongoing problem.
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Chapter 1

About Publishing Symbols
to the Web

You use the ArchestrA Web Exporter to publish ArchestrA Symbols 
and InTouch Windows to the web. The ArchestrA Web Exporter is a 
utility you can download from the Wonderware Information Server 
portal. 

About the ArchestrA Web Exporter
The ArchestrA Web Exporter is intended for application engineers who 
want to configure displays on the Wonderware Information Server 
that connect to both live and historical data.

It lets you transform and publish ArchestrA Graphics to the web as 
well as transform and publish InTouch Windows. 

You must install the ArchestrA Integrated Development Environment 
(IDE) before installing the ArchestrA Web Exporter. 

After the installation, you can start the ArchestrA Web Exporter from 
the ArchestrA IDE toolbar, from the Object menu, or from the context 
menu of an InTouchViewApp object. 

For more information on how to install the ArchestrA Web Exporter, 
see "Installing the ArchestrA Web Exporter" on page 19.
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The following diagram shows in more detail how the ArchestrA Web 
Exporter operates in the ArchestrA environment:

Note:  The ArchestrA Web Exporter can also transform Windows of 
managed InTouch applications. This is not shown in the diagram above. 

With the ArchestrA Web Exporter you can: 

• Transform ArchestrA Symbols or InTouch Windows. These reside 
on the local file system.

• Manage your transformed content in Web Projects, WindowSets, 
TableWeaverSets, and folders. 

• Preview the transformed content before publishing it.

• Publish transformed content to one or more Information Server 
portals. 

• Republish changed content to the Information Server.

The web user can browse and interact with published ArchestrA 
Symbols and InTouch windows by accessing the Information Server 
portal. 
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About ArchestrA Web Projects
The ArchestrA Web Exporter uses Web Projects to store configuration 
information for the transformed ArchestrA Symbols and InTouch 
Windows. A Web Project corresponds to a folder on the local file 
system.

You can only open one Web Project at a time in the ArchestrA Web 
Exporter.

Online and Offline Modes
You can operate the ArchestrA Web Exporter in two different modes:

• Offline mode: Use this mode to transform and manage ArchestrA 
Symbols and InTouch Windows. The offline mode shows 
transformed content ready to be published and no live data. All 
operations in offline mode only affect the local configuration set.

• Online mode: Use this mode to connect to an Information Server 
portal and view how the published content appears. You can also 
use this mode to delete published content from the portal. All 
operations in online mode only affect published content to the 
portal.

About Displays
Before you can publish ArchestrA Symbols and InTouch Windows to 
the web, you must transform them with the ArchestrA Web Exporter. 

Transformed ArchestrA Symbols and InTouch Windows are called 
“displays”.

Displays are Microsoft Silverlight XAP files that can be directly 
opened in a web browser with an installed Silverlight-plugin. 

If you do not have Silverlight installed on a computer when you open a 
published display, Internet Explorer asks you to download the latest 
version of Microsoft Silverlight. 

To be able to transform InTouch Windows and ArchestrA Symbol, you 
also need the Microsoft Silverlight SDK. You can download Microsoft 
Silverlight and Microsoft Silverlight SDK from the Wonderware 
Information Server portal when you install the ArchestrA Web 
Exporter. 

To publish displays to the portal, you must be a member of the 
Administrator role on the Wonderware Information Server. For more 
information on user roles, see the Wonderware Information Server 
Administration Guide.
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Displays as Transformed ArchestrA Symbols
You can create displays from ArchestrA Symbols contained in one of 
the following:

• Graphic Toolbox

• Automation Object template

• Automation Object instance

ArchestrA Symbols may contain references that cannot be resolved 
without further configuration, such as:

• Relative references (me, myContainer, myHost, myArea, myEngine, 
or myPlatform).

• Unresolved references indicated by “---”. 

In both cases, you can map the unresolved references during 
conversion to Automation Object instances, literal values, absolute or 
relative references. 

Note:  You cannot map unresolved references to expressions, such as 
tag1 + 13. 

Displays as Transformed InTouch Windows
You can create displays from InTouch Windows of managed InTouch 
applications. The Windows can contain InTouch native graphics, 
SmartSymbols, Wizards, and embedded ArchestrA Symbols.

Note:  Stand-alone and published InTouch applications are not 
supported by the ArchestrA Web Exporter.

You can organize your displays under WindowSets. Each WindowSet 
uniquely identifies a the computer name from which the publish 
displays retrieve their InTouch data. 

When you transform InTouch Windows to WindowSet displays, you 
can let the ArchestrA Web Exporter automatically create the same 
folder structure in the Publishing pane as the folder structure in the 
Project View of the InTouch application.

For more information on unsupported InTouch Window content, see 
"Limitations of the ArchestrA Web Exporter" on page 55.
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Organizing Displays
WindowSets, TableWeaverSets, and folders help you organize displays 
within an ArchestrA Web Project. 

• Displays published from WindowSets show you live plant data on 
the Web.

• Displays published from TableWeaverSets show you historical 
plant data on the Web. 

WindowSets
WindowSets are used for displays that you publish to the Information 
Server portal. Published displays from WindowSets appear under the 
ArchestrA Graphics node in the Information Server portal.

You can configure a WindowSet with a name of a computer running 
WindowViewer. 

A WindowSet can contain displays with or without a folder hierarchy. 

WindowSet names need to be unique within a Web Project. 

Folders
Folders are containers for displays to help you organize displays 
within WindowSets. You can create a hierarchy of folders in a 
WindowSet to contain your displays.

When you transform InTouch Windows to displays, you can optionally 
let ArchestrA Web Exporter create the same folder hierarchy as the 
Project View in the InTouch application. 

TableWeaverSets
You can use TableWeaverSets to contain and manage displays that 
you publish to the Information Server portal for visualization of 
historical plant data from the Wonderware Historian. 

You can only transform ArchestrA Symbols to displays under 
TableWeaverSets. InTouch Windows are not supported.

Published displays from TableWeaverSets appear in Table Weaver the 
Information Server portal. 

After you publish displays to the Wonderware Information Server as 
Table Weaver displays, you cannot interact with them, such as using:

• Sliders to change values

• Pushbutton animation

• Action scripts

• Show Symbol or Hide Symbol animations
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However, TableWeaverSet displays can show sliders and other 
elements of interaction, such as switch wizards and others.

TableWeaverSet names need to be unique within a Web Project. 

Previewing Displays
After you transform ArchestrA Symbols or InTouch Windows to 
displays in the Publishing pane, you can preview the displays within 
the ArchestrA Web Exporter before publishing. This is known as 
Offline mode.

When you preview displays in offline mode, the displays do not show 
live data and animations that depend on InTouch tags or ArchestrA 
Galaxy attributes. If the elements use animations that exclusively use 
local data, such as custom properties or local script variables, the 
elements will be animated and you can interact with them.

Data Sources for Published Displays
There are certain requirements that must be met so that a published 
display can read and write data back to its data source.

Using ArchestrA as a Data Source
Published displays use a service called the ArchestrA LMX Publisher 
Service to handle data communication between the Information Server 
and the Galaxy.

You can only use the Galaxy that deployed the WinPlatform to the 
Information Server computer. If you publish a display using a data 
reference that exists in another Galaxy, the reference only works for 
the Galaxy that published the display. 

If you deploy a WinPlatform from a different Galaxy to the 
Information Server node, you need to restart the ArchestrA LMX 
Publisher on the Information Server node. Otherwise the data in 
published symbols and windows does not update.

To publish displays to the portal, you must be a member of the 
Administrator role on the Wonderware Information Server. For more 
information on user roles, see the Wonderware Information Server 
Administration Guide.
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Using WindowViewer as a Data Source
If your published displays use InTouch WindowViewer as a data 
source, you need to configure the WindowSet hosting the published 
display to specify the computer name on which InTouch 
WindowViewer is running. 

Using Other Data Sources
You can use other data sources besides Galaxy data and InTouch tags, 
such as data from DAServers and I/O Servers if the data is configured 
in ArchestrA Automation objects or in the InTouch application.

There is no need for additional configuration in the ArchestrA Web 
Exporter.

For example: 

• Device Integration Automation Objects, such as the OPCClient 
object to access data from external sources such as a DAServer.

• I/O tags and direct references in the InTouch HMI to access data 
from a DAServer or any other supported data source.

Application Logic for Transformed InTouch 
Windows

InTouch windows that have been transformed with the ArchestrA Web 
Exporter do not contain any application logic; that is, they do not 
execute scripts locally. 

What this means for InTouch application developers is that the 
InTouch windows shown to end users are separated from the data 
sources and any application logic (for example, scripts) that allows a 
user to interact with the data sources.

Browser-based windows can execute scripts, but these scripts must not 
be of the application type and must only be used when the logic 
pertains to the individual use of the individual window. The 
browser-based windows interact and change according the application 
logic running in the InTouch plant floor application.

The logic and data are provided by a specified InTouch computer 
(node), which also provides the animation information and actual data 
for the window.
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About Publishing Displays
You can publish displays from ArchestrA Web Exporter to the 
configured Information Server portal. You can do so at the following 
levels:

When you publish to the Information Server, all content is copied and 
merged to existing content on the Server. If a display already exists on 
the portal, a confirmation dialog box appears showing you which 
displays are already published to the portal and will be overwritten. 

To publish windows to Wonderware Information Server, you must:

• Have been given permission to publish. You need to be a member 
of the Information Server Administrator role. For more 
information on configuring the roles, see the Wonderware 
Information Server Administration Guide.

• Have an HTTP connection to the site.

You do not have to be logged on the web server computer to publish a 
window. Also, you do not need to have a connection with the 
application node supplying the data.

Level Description

Project All WindowSets and TableWeaverSets are 
published to the Information Server.

WindowSet The WindowSet, all folders, sub-folders, 
and displays contained in the WindowSet 
are published to the Information Server.

TableWeaverSet The TableWeaverSet and its displays are 
published to the Information Server.

Folder The folder, all sub-folders, and displays 
contained in the folder structure are 
published to the Information Server.

Display Just the display is published to the 
Information Server.
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Security for Viewing Published Windows
Wonderware Information Server is fully integrated with Windows 
security. Wonderware Information Server administrators can give 
Windows domain users privileges to read, write, or configure the 
system. Wonderware Information Server also supports the SSL 
Internet protocols for additional security, and the system works 
behind firewalls.

Access, right-privileges, and other security settings are determined by 
the role to which a user is assigned by the Wonderware Information 
Server administrator. 

In Wonderware Information Server, no user can effect changes 
(write-back) unless: 

• This has been enabled for the site by the Wonderware Information 
Server administrator.

• There is a specific write-back license installed.

• The user has been assigned to the engineer role with write-back 
privileges. 

There are also advanced security options beyond what Wonderware 
Information Server provides. For detailed information on configuring 
security, see the Wonderware Information Server Administration 
Guide. 

Viewing Published Displays with the ArchestrA 
Web Exporter

After you publish displays to the Information Server, you can view 
them in the ArchestrA Web Exporter. This is known as Online mode.

When you view displays in online mode, you are seeing the display as 
it appears to a user accessing the Information Server portal. You can 
interact with the display, and the display shows live data and 
animations. 
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Combined Internet/Intranet Access
If your users are accessing Wonderware Information Server from both 
the Internet and a company intranet, then both the Internet and 
intranet URL for your web server must be listed in your corporate 
DNS server or LMHOSTS file. 

This is because a web server is usually known by one name on the 
Internet and another on the intranet. 

Another solution is to create different WindowSets or 
TableWeaverSets for the different users, each using the web server 
URL that can be resolved by their system. 

The following diagram shows a typical network configuration for 
operating in an ArchestrA environment where users can visualize and 
interact with ArchestrA Symbols and InTouch windows from the web.
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Chapter 2

Using the ArchestrA Web
Exporter

The ArchestrA Web Exporter uses Web Projects to manage 
transformed ArchestrA Symbols and InTouch Windows. This section 
shows you how to install the ArchestrA Web Exporter, manage your 
Web Projects, and to transform and publish ArchestrA Symbols and 
InTouch Windows to the web. 

Installing the ArchestrA Web Exporter
You must install the ArchestrA Web Exporter on a computer that has 
ArchestrA IDE installed and has access to the Wonderware 
Information Server.

You need to log on as portal administrator to be able to install the 
ArchestrA Web Exporter. 

To install and start the ArchestrA Web Exporter

1 Close ArchestrA IDE.

2 Open the Information Server portal in a web browser.

3 In the System panel, expand Administration.

4 Click ArchestrA Web Exporter. 
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5 If you have not already installed Microsoft Silverlight 5.0, do the 
following:

a Click Download Silverlight 5.0.

b Click Run, then click Run again.

c Click Install now.

d When the installation is complete, click Finish.

6 Click Download ArchestrA Web Exporter. 

7 Click Run, then click Run again.

8 Follow the instructions of the installation wizard.

9 Open the ArchestrA IDE. 

• A new icon appears on the toolbar. 

• A menu item Open/Create Web Project appears on the Object 
menu.

• Three menu item Open Last Web Project, Create Web Project, 
and Open Web Project appear on the context menu of 
managed InTouch applications. 

10 Click the toolbar icon and select Create Web Project to start the 
ArchestrA Web Exporter. 

Managing Web Projects
The ArchestrA Web Exporter manages your Web Projects that contain 
WindowSets, TableWeaverSets, folders and displays. 

You can create Web Projects, re-open Web Projects, rename Web 
Projects, change the name of the computer that provides InTouch data 
and change the URL of the portal.

Creating a Web Project
You can create a Web Project from:

• The ArchestrA Web Exporter icon list.

• The context menu of a managed InTouch application.

• The Object menu in the ArchestrA IDE.

• The File menu of the ArchestrA Web Exporter.
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To create a new Web Project

1 Access the Create Web Project dialog box. Do any of the following: 

• Click the ArchestrA Web Exporter icon on the toolbar and click 
Create Web Project.

• Right-click a managed InTouch application template and click 
Create Web Project.

• On the Object menu in the ArchestrA IDE, click Create/Open 
Web Project, and then click Create Web Project. 

• In the ArchestrA Web Exporter on the File menu, click New 
Project.

The Create Web Project dialog box appears.

Note:  If you open this dialog box from a deployed InTouch application, 
the InTouch data source node is automatically set to its hosting 
WinPlatform object.

2 In the Project Name box, type the name of your new Web Project.

3 In the Local Project Path box, keep the default setting or type the 
local path name or browse for the local path that will contain the 
Web Project. You can also use a network drive location or a 
network share location.

4 In the InTouch Data Source Node box, type the name of the 
computer on which InTouch WindowViewer will run. This can be 
the name of the computer to which you deploy a managed InTouch 
application. 

5 In the Information Server URL box, type the full address of the 
Wonderware Information Server to which you publish, for example 
http://MyWISServer/Wonderware.

Note:  If you use a secured HTTP connection or a custom port to 
access the Information Server, you can type https and port number in 
the URL. For example: https://WISServer:8443/Wonderware
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6 Click Verify URL. An authentication dialog box appears. 

7 Type a user name with Information Server administrator rights 
and password, and then click OK.

If the authentication is successful, a confirmation message 
appears.

8 Click OK. If a Web Project already exists in the given local project 
path, a confirmation dialog box appears. Click Yes.

Your Web Project is created and the ArchestrA Web Exporter 
appears. 

Opening a Web Project
You can open a Web Project using one of the following methods: 

• The last opened Web Project. Use this option if you want to quickly 
re-use the ArchestrA Web Exporter to publish displays.

• A recently opened Web Project or any Web Project. Use this option 
if you are using multiple Web Projects at the same time.

You can open a Web Project from either the ArchestrA IDE or from the 
ArchestrA Web Exporter directly.

To open the last Web Project

 Do one of the following: 

• In the ArchestrA IDE, click the ArchestrA Web Exporter icon, 
and then click Open Last Web Project. 

• In the ArchestrA IDE on the Object menu, click Create/Open 
Web Project. 

• On the context menu of a managed InTouch application 
template, click Open Last Web Project.

The ArchestrA Web Exporter appears with last opened Web 
Project.
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To open a recent or any Web Project

1 Access the Open Web Project dialog box. Do any of the following:

• In the ArchestrA IDE, click the ArchestrA Web Exporter icon, 
and then click Open Web Project.

• On the context menu of a managed InTouch application 
template, click Open Web Project.

• In the ArchestrA Web Exporter on the File menu, click Open 
Web Project. 

The Open Web Project dialog box appears.

2 Do one of the following:

• Select a project from the Recent Projects list and click OK. 

• Click on the browse icon and browse for a Web Project. Click 
Open, and then click OK.

The ArchestrA Web Exporter appears with selected Web Project.
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Renaming a Web Project
Renaming a Web Project has no effect on the published or unpublished 
displays, folders, WindowSets, or TableWeaverSets.

To rename a project

1 In the ArchestrA Web Exporter, right-click the project name in the 
Publishing pane, and then click Properties. The Project 
Properties dialog box appears.

2 In the Project Name box, type a new Web Project name and click 
OK. 

Changing the InTouch Data Source Node of a 
Web Project

You can change the InTouch data source node of all WindowSets by 
changing the InTouch data source node in the project properties and 
applying this change to the WindowSets.

You would typically do this if you are switching to an InTouch backup 
node for all WindowSets.

After you change the InTouch data source node of a project, any new 
WindowSets automatically use the new name as the InTouch data 
source. You must republish the Web Project for the change to take 
effect.
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To change the InTouch data source node of a project

1 In the ArchestrA Web Exporter, right-click the project name in the 
Publishing pane, and then click Properties. The Project 
Properties dialog box appears.

2 In the InTouch Data Source Node box, type the new name of the 
computer on which the managed InTouch application runs.

3 If you want to apply this change to all WindowSets in the project, 
do the following: 

a Click Sync WindowSets. A confirmation message appears. 

b Click Yes.

4 If you want to reset the InTouch data source nodes of all 
WindowSets to their originally configured nodes, do the following:

a Click Default. A confirmation message appears.

b Click Yes.

5 Click OK.

6 Transform the converted InTouch Windows and ArchestrA 
Symbols again.

7 Republish the Web Project to the portal.
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Customizing the ArchestrA Web Exporter
After you create a new Web Project, you can customize the layout of 
the ArchestrA Web Exporter to your needs.

To customize the layout of the ArchestrA Web Exporter

1 Grab the bars between the panes to enlarge or shrink the:

• Width of the Publishing pane

• Height of the Source pane

• Height of the Preview and Information pane

2 Click the expand and shrink icons to minimize or restore the size of 
the panes.

3 Double-click the title bar of the:

• Publishing pane to minimize or restore the width of the 
Publishing pane.

• Source pane to maximize or restore the size of the Source pane.

• Preview and Information pane to maximize or restore the size 
of the Preview and Information pane. 

Source
Pane

Toolbar

Publishing
Pane

Status
Bar

Information
and Preview
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4 On the View menu, clear or check: 

• Publishing Pane to minimize or restore the width of the 
Publishing pane.

• InTouch Windows and ArchestrA Symbols to minimize or 
restore the height of the Source pane.

• Preview and Information to minimize or restore the height of 
the Preview and Information pane.

5 On the View menu, click Restore Layout to restore all pane sizes 
to their default values. 

Managing WindowSets and Folders
You can use WindowSets and folders to contain and organize your 
displays. WindowSets are top-level folders that can contain folders. 
You can set the properties of a WindowSet to a computer name as data 
source of an InTouch application.

Creating WindowSets
In the ArchestrA Web Exporter, you can create additional WindowSets 
to host folders and displays. 

Each WindowSet is configured with a computer name. If the displays 
in the WindowSet use InTouch as a data source, the computer name 
identifies the computer on which the managed InTouch application 
runs.

To create a WindowSet

1 In ArchestrA Web Exporter, right-click the project name in the 
Publishing pane, and then click New WindowSet. A new 
WindowSet is added to the Publishing pane under the project 
name.

2 Type a new name for the WindowSet and press Enter. You can now 
add folders or drag ArchestrA Symbols or InTouch Windows to the 
WindowSet.
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Creating Folders
You can use folders under WindowSets to organize the structure of the 
displays. When you publish WindowSets, folders or displays, the 
folders are created on the portal.

To create a folder

1 In ArchestrA Web Exporter, right-click a WindowSet or a folder, 
and then click New Folder. A new folder is added to the Publishing 
pane under the WindowSet or folder.

2 Type a new name for the folder and press Enter. You can now drag 
ArchestrA Symbols or InTouch Windows to the folder.

Renaming WindowSets and Folders
You can rename WindowSet (or folder) at any time. You can only 
rename a WindowSet (or folder) in offline mode.

When you rename a WindowSet (or folder), the new name has no effect 
on the name of the published WindowSet (or folder). If you republish 
the WindowSet (or folder), a new WindowSet (or folder) with the new 
name is created on the portal.

To change the name of a WindowSet or folder

1 In the ArchestrA Web Exporter, right-click the WindowSet or 
folder you want to rename, and then click Rename. The selected 
WindowSet (or folder) appears in edit mode.

Note:  You can also click one time on an already selected WindowSet 
(or folder). The selected item appears in edit mode.

2 Type a new name for the WindowSet (or folder) and press Enter. 

p
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Deleting Local Copies of WindowSets and Folders
You can delete a local copy of a WindowSet (or folder) by switching to 
offline mode and deleting it from the Publishing pane. The published 
WindowSet (or folder) on the portal is not deleted. 

When you delete a: 

• WindowSet, all contained folders and displays are deleted at the 
same time.

• Folder, all contained displays are deleted at the same time.

To delete a local copy of the WindowSet or folder

1 In the ArchestrA Web Exporter, switch to offline mode.

2 Right-click the WindowSet or folder you want to delete, and then 
click Delete. A warning message appears.

3 Click Yes. The selected WindowSet (or folder) is deleted from the 
local computer.

Deleting WindowSets and Folders on the Portal
You can delete a WindowSet (or folder) on the Portal by switching to 
online mode and deleting it from the Publishing pane. The local 
WindowSet (or folder) is not deleted and can be republished any time. 

When you delete a: 

• WindowSet, all contained folders and displays are deleted at the 
same time.

• Folder, all contained displays are deleted at the same time.

To delete a WindowSet or folder on the portal

1 In the ArchestrA Web Exporter, switch to online mode.

2 Right-click the WindowSet or folder you want to delete, and then 
click Delete. A warning message appears.

3 Click Yes. The selected WindowSet (or folder) is deleted from the 
portal.
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Changing the InTouch Data Node of a WindowSet 
You can change the InTouch data source node of any WindowSet by 
changing the InTouch data source node in the WindowSet properties.

To change the InTouch data source node of a WindowSet

1 In the ArchestrA Web Exporter, right-click the WindowSet for 
which you want to change the InTouch data source node, and then 
click Properties. The WindowSet Properties dialog box appears.

2 Select the Different than Project check box.

3 In the InTouch Node for WindowSet box, type the new node name 
for the InTouch data source.

4 Click OK. 

5 Transform the converted InTouch Windows and ArchestrA 
Symbols again.

6 Republish the WindowSet to the portal. 
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Managing TableWeaverSets
You can create, rename, and delete TableWeaverSets. 

Creating TableWeaverSets
In the ArchestrA Web Exporter, you can create additional 
TableWeaverSets to host displays. 

There is no specific configuration for a TableWeaverSet. You use it 
only so that you can publish transformed displays with one single 
publishing operation. 

To create a TableWeaverSet

1 In the ArchestrA Web Exporter, right-click the project name in the 
Publishing pane, and then click New TableWeaverSet. A new 
TableWeaverSet is added to the Publishing pane under the project 
name.

2 Give the TableWeaverSet a new name and press Enter. You can 
now drag ArchestrA Symbols to the TableWeaverSet. 

Renaming TableWeaverSets
You can rename a TableWeaverSet at any time. You can only rename 
a TableWeaverSet in offline mode.

When you rename a TableWeaverSet, the new name has no effect on 
published TableWeaverSets. 

To change the name of a TableWeaverSet

1 In the ArchestrA Web Exporter, right-click the TableWeaverSet 
you want to rename, and then click Rename. The selected 
TableWeaverSet appears in edit mode.

Note:  You can also click one time on an already selected 
TableWeaverSet. The selected item appears in edit mode.

2 Type a new name for the TableWeaverSet and press Enter. 
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Deleting Local Copies of TableWeaverSets
You can delete a local copy of a TableWeaverSet by switching to offline 
mode and deleting it from the Publishing pane. The published 
TableWeaverSet on the portal is not deleted. 

When you delete a TableWeaverSet, all contained displays are deleted 
at the same time. 

To delete a local copy of the TableWeaverSet

1 In the ArchestrA Web Exporter, switch to offline mode.

2 Right-click the TableWeaverSet you want to delete, and then click 
Delete. A warning message appears.

3 Click Yes. The selected TableWeaverSet is deleted from the local 
computer.

Deleting TableWeaverSets on the Portal
You can delete a TableWeaverSets on the Portal by switching to online 
mode and deleting it from the Publishing pane. The local 
TableWeaverSet is not deleted and can be republished any time. 

When you delete a TableWeaverSet, all contained displays are deleted 
at the same time.

To delete a TableWeaverSet on the portal

1 In the ArchestrA Web Exporter, switch to online mode.

2 Right-click the TableWeaverSet you want to delete, and then click 
Delete. A warning message appears.

3 Click Yes. The selected TableWeaverSet is deleted from the portal.

Managing Displays
Displays are transformed ArchestrA Symbols and InTouch Windows 
and appear under folders, WindowSets, or TableWeaverSets in the 
Publishing pane.

You cannot rename a display, but you can do the following:

• Delete a published display from the Information Server.

• Delete the local display.

• Change the properties of a display as you would with a file.
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Deleting a Display
You can delete a display at any time. 

In offline mode, deleting a display has no effect on the published 
display. 

In online mode, deleting a display means the display is deleted from 
the Information Server portal. The local display is not deleted and can 
be republished any time. 

To delete a display

1 In the ArchestrA Web Exporter, right-click the display you want to 
delete, and then click Delete. A warning message appears.

2 Click Yes. The selected display is deleted.

Changing the Properties of a Display
You can change the properties of a display as you would with a normal 
Windows file. For example, you make it read-only so that it cannot be 
accidentally overwritten.

To change the properties of a display

1 In the ArchestrA Web Exporter, right-click the display, and then 
click Properties. The file properties dialog box appears. 

2 If necessary, make changes to the file properties and click OK. 

Transforming ArchestrA Symbols and InTouch 
Windows

You can transform ArchestrA Symbols and InTouch Windows to 
displays with the ArchestrA Web Exporter by dragging them from the 
Source pane to the Publishing pane.

Transforming ArchestrA Symbols
You transform ArchestrA Symbols by dragging them from the 
ArchestrA Symbols pane to a WindowSet, TableWeaverSet, or folder in 
the Publishing pane. You can transform ArchestrA Symbols from the 
Graphics Toolbox, from object templates, and from object instances. 

Note:  At any time you can refresh the source pane to show the latest 
symbols, objects, toolsets, or InTouch Windows. Press F5, click the 
Refresh icon, or click Refresh on the View menu.
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To transform ArchestrA Symbols

1 In the ArchestrA Web Exporter, click the ArchestrA Symbols tab.

2 On the toolbar, click the source of the ArchestrA Symbol: 

3 Drag one or more ArchestrA symbols you want to transform to the 
WindowSet you want to use to host the symbols. To multi-select 
items, you can use one of the following methods:

a Hold the Ctrl key and click the items you want to select.

b Click one item, then hold the Shift key and click another item 
to select all items between the clicked items. 

c Drag a rubber band selection around the items you want to 
select.

If any of the ArchestrA symbols you are transforming contains 
unresolved configuration, the Unresolved Configuration in 
Symbols dialog box appears. For more information, see "Resolving 
Unresolved Configuration in Symbols" on page 36.

A conversion dialog box appears and shows you the progress of the 
conversion. 

Icon Purpose

Shows the Automation Object templates on the left. 
You can select a template to show its hosted ArchestrA 
Symbols.

Shows the ArchestrA Symbols and Toolsets in the 
Graphic Toolbox.

Shows the Automation Object instances on the left. 
You can select an instance to show its hosted 
ArchestrA Symbols. 
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After a short while, the transformed symbols appear under the 
selected WindowSet. 

If the transformed symbols use a ShowSymbol animation, a 
message appears for each symbol asking if you also want to 
transform the linked ArchestrA Symbols. 

If you click Yes, the ArchestrA symbol is transformed together 
with any linked ArchestrA Symbols. 

Select Apply to all similar symbols/windows if you don’t want to 
be prompted for each symbol that has a ShowSymbol animation.

The linked ArchestrA Symbols appear as child nodes under the 
new display. 

4 Read the information on the Information pane for any errors and 
warnings during the conversion. 
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5 If you want to preview the transformed ArchestrA Symbol or 
InTouch Window, click the Preview tab. 

Resolving Unresolved Configuration in Symbols
When an ArchestrA Symbol uses relative references that cannot be 
resolved by the ArchestrA Web Exporter, or when the Symbol 
configuration uses the “---” placeholder in custom property values, the 
Unresolved Configuration in Symbols dialog box appears. 
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Note:  If you do not resolve the references, the published display may 
not work correctly in the Information Server portal unless the 
references are set by run-time scripting. 

To resolve unresolved configuration in ArchestrA Symbols

1 In the Unresolved Configuration in Symbols dialog box, click an 
item with “---” placeholder.

2 If the item is a symbol, you must associate the symbol with an 
Automation object instance. To do this:

a Next to the Owning Object box, click the Browse button. The 
Galaxy Browser appears.

b Select an Automation Object instance to associate with the 
symbol and click OK. 

3 If the item is a custom property, you must specify a value or a 
reference for the custom property. To configure a reference: 

a Next to the Value box, click the Browse button. The Galaxy 
Browser appears.

b Select an Automation Object instance on the left. The right 
pane shows the attributes of the selected instance.

c Select an attribute and click OK. 
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If you want to configure a value instead of a reference, do the 
following:

a Click the label button to the left of the Value box, so that it 
shows the value icon.

b In the Value box, type a value for the custom property. 

Note:  You cannot use an expression as a value. 

4 You can click Next to configure the next unresolved item, or Back 
to configure the previous unresolved item.

5 After you configure all unresolved items, you can click OK.

If some items are still unresolved, a warning message appears. 

Click Yes to ignore the warning and start the conversion, or click 
No to go back and configure the unresolved items.

Transforming InTouch Windows
You transform InTouch Windows by dragging them from the InTouch 
Windows pane to a WindowSet, or a folder in the Publishing pane.

When you transform an InTouch Window, all native InTouch graphics, 
all embedded ArchestrA Symbols, and related pop-up Windows of the 
InTouch Window are also transformed. 

Note:  If the InTouch Window contains ArchestrA Symbols with 
unresolved references, the Unresolved References in Symbols dialog 
box does not appear. You need to configure the ArchestrA Symbol so 
that it can resolve its own unresolved references at run time. 
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To transform InTouch Windows

1 In the ArchestrA Web Exporter, click the InTouch Windows tab.

2 On the File menu, click Open managed InTouch application.  The 
Open Managed InTouch Application dialog box appears. 

3 Select the InTouch application and click OK. The source pane 
shows the InTouch Windows of the selected InTouch application. 

4 Drag an InTouch Window to the Publishing pane. 

Note:  If you want to transform more than one InTouch Window at a 
time, click the Details View icon to switch to a detailed list of InTouch 
Windows. 

A message may appear asking if you want to always create the 
same folder hierarchy in the Publishing pane as the folder 
hierarchy in the InTouch application.
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5 Click:

• Yes. The ArchestrA Web Exporter transforms your InTouch 
windows and creates the same folder hierarchy in the 
Publishing pane as the folder hierarchy in the InTouch 
application. It will not ask you again. 

• No. The ArchestrA Web Exporter simply transforms the 
InTouch windows as displays in the WindowSet or 
TableWeaverSet you dragged them to. 

Note:  For more information on how to change the conversion behavior 
and disable the message, see "Setting Conversion Behavior for InTouch 
Windows" on page 40.

Setting Conversion Behavior for InTouch Windows
When you transform an InTouch Window, the ArchestrA Web 
Exporter can automatically create the same folder hierarchy as the 
Project View folder hierarchy in the InTouch HMI hosting the InTouch 
Window. 

You can configure the ArchestrA Web Exporter to automatically: 

• Always create the folder structure

• Never create the folder structure

• Prompt you each time to create the folder structure

To always automatically create the folder structure

 Do one of the following:

• On the Options menu, select Automatically create WindowSet 
folders. 

• Convert an InTouch Window and click Yes when you are 
prompted to always automatically create folders.

To never automatically create the folder structure

 On the Options menu, clear: 
• Automatically create WindowSet folders 

• Ask user to automatically create WindowSet folders
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To prompt you each time to automatically create the folder 
structure

 On the Options menu, select Ask user to automatically create 
WindowSet folders. 

Previewing ArchestrA Symbols and InTouch 
Windows

You can preview transformed ArchestrA Symbols and InTouch 
Windows in the ArchestrA Web Exporter before publishing them to the 
portal. 

After publishing, you can also use the ArchestrA Web Exporter to view 
the published display as it appears in the portal. For more 
information, see "Viewing Published Displays" on page 44.

To preview displays before publishing

1 On the File menu, make sure Switch between offline and online 
modes is not selected.  The WindowSet, folder, and display names 
appear in black.

2 In the Publishing pane, click the display you want to preview. 

3 Click the Preview tab in the Preview and Information pane. 
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Publishing ArchestrA Symbols and InTouch 
Windows

You can publish displays to the Information Server Portal as 
configured in the Web Project Properties dialog box. You can also 
publish the displays to a different Information Server Portal.

You can only publish one display at a time. To publish more displays 
at the same time, you can either publish a folder, WindowSet or 
TableWeaverSet containing displays or the entire Web Project. 

You can publish the display to resize automatically to the portal web 
window (Fit to Window), or in its original size.

To publish displays to the portal, you must be a member of the 
Administrator role on the Wonderware Information Server. For more 
information on user roles, see the Wonderware Information Server 
Administration Guide.

Note:  You cannot publish a transformed symbol that is current 
checked out. Checked-out ArchestrA symbols appear with a check mark 
in the Publishing pane. To publish the symbol, check the ArchestrA 
Symbol in first, then transform it again and publish it.

Publishing Displays to the Information Server 
Portal

You can publish displays from the Publishing pane to the Information 
Server portal. When you do so, the folders and WindowSet or 
TableWeaverSet containing the display are created on the portal. 

Note:  By default, the Fit to Window option is selected on the shortcut 
menu of a display. If you want the published display to appear in 
original size on the portal, click Fixed Size Window on the shortcut 
menu. 



Publishing ArchestrA Symbols and InTouch Windows43

Wonderware ArchestrA Web Exporter Guide

To publish a display to an Information Server portal

1 In the ArchestrA Web Exporter, right-click the display you want to 
publish, and then click Publish. 

If the display you are publishing already exists on the Information 
Server portal, a warning message appears. Click OK to overwrite 
the published displays.

The Publishing Status dialog box appears showing you the 
progress.

2 When the publishing is finished, click Close. 

Publishing Displays to a Different Information 
Server Portal

You can change the Information Server URL if you want to publish the 
same project to a different Information Server Portal. 

To publish a display to a Different Information Server Portal

1 In the ArchestrA Web Exporter, right-click the project name in the 
Publishing pane, and then click Properties. The Project 
Properties dialog box appears. 

2 In the Information Server URL box, type the full URL of the 
Information Server portal you want to publish to.

3 Optionally, click Verify URL. The ArchestrA Web Exporter checks 
if the Information Server URL is correct and shows a message.

4 Click OK. You can now republish WindowSets and 
TableWeaverSets to the new Information Server portal. For more 
information, see "Publishing Displays to the Information Server 
Portal" on page 42.
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Viewing Published Displays
After you publish ArchestrA Symbols or InTouch Windows to the 
Information Server, you can view them within the ArchestrA Web 
Exporter without having to open in the Internet Explorer. 

To view published displays

1 On the File menu, make sure Switch between offline and online 
modes is selected.  The WindowSet, folder, and display names 
appear in blue.

2 In the Publishing pane, click the display you want to preview. 

The right side of the ArchestrA Web Exporter shows the published 
display as it would appear in a portal.
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Chapter 3

Using Published Displays
on the Web

After you publish a WindowSet display, you can view and interact with 
it in the ArchestrA Graphics node of the Information Server.

You can also configure published TableWeaverSet displays inside the 
Table Weaver Manager and view them in Table Weaver.

Viewing Published WindowSet Displays
You can view published displays in the Wonderware Information 
Server portal from any computer with Internet Explorer. 

To view published WindowSet displays in the Information 
Server

1 Start Internet Explorer and browse to the Information Server, 
such as http://mycompany/Wonderware. The Information 
Server Portal page opens.

2 On the Launch Pad panel, expand ArchestrA Graphics. One or 
more WindowSet nodes appear.

3 Expand the WindowSet containing the published displays.
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4 Click the link of the published display. The published display 
appears on the right. 

After a short while, if the published display uses live data from the 
ArchestrA Galaxy or from InTouch, live data appears in batch of 
500 elements until all elemenst are handled and the published 
display is animated. 
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Showing Quality and Status
You can show Quality and Status as you would with ArchestrA 
Symbols in a desktop environment. ArchestrA Symbols published to 
the web show Status elements and element overrides as configured in 
the Configure Quality and Status Display dialog box in the ArchestrA 
IDE. 

If you make changes to the overrides in the Configure Quality and 
Status Display dialog box in the ArchestrA IDE, you simply need to 
reload the web page with the published ArchestrA Symbol for the 
changes to take effect.

Note:  You cannot show Quality and Status information from a 
non-ArchestrA data source, such as from an InTouch tag that is 
referencing an I/O source.

Executing Scripts
You can only execute the following scripts in a published display:

• InTouch Window Script

• InTouch Action Script

• ArchestrA Symbol Predefined Script

• ArchestrA Named Script

The script execution writes back values to external data sources such 
as InTouch tags and ArchestrA attributes only at the end of the script 
execution. 
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This approach reduces the amount of communication between the web 
application and the data source. It also means higher performance for 
the web application.

Note:  This applies to InTouch tags and Galaxy attributes only. Values 
are written back immediately to custom properties during script 
execution.

Example

dim i as integer;

ud1.int1 = 0;

for i = 1 to 100

ud1.int1 = ud1.int1 + 3;

next;

In the example, zero is not written back to the Galaxy attribute 
ud1.int1 during script execution. Instead an internal “invisible” 
variable is used instead of the actual reference during script execution. 

This variable is increased 100 times by the value of 3, the result is 
then written back to the actual Galaxy reference at the end of the 
script execution. 

In other words, the value 300 is written back to the Galaxy reference 
ud1.int1 one time at the end of the script execution.

Interacting with Published WindowSet Displays
You can interact with published displays in the Wonderware 
Information Server portal from any computer with the Internet 
Explorer as you would with the ArchestrA Symbols and InTouch 
Windows in a desktop environment.

Interaction includes:

• Creating a Galaxy Repository and importing Script Function 
Library from the following file:

• 32bit OS: C:\Program 
Files\ArchestrA\Framework\Bin\QuickScriptLibraryAdd
On.dll

• 64bit OS: C:\Program Files 
(x86)\ArchestrA\Framework\Bin\QuickScriptLibraryAdd
On.dll

• Using the methods under the namespace Browser in the Script 
Function Browser
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Enabling Write-Back to the Galaxy and InTouch
To be able to write back values from the Information Server portal to 
the Galaxy or InTouch, you must: 

• Add the Information Server user to the Information Server 
Engineering role.

• Enable tag server write-back in the License Manager.

To enable write-back to the Galaxy and InTouch

1 Log on to the Information Server portal with an administrator 
account.

2 In the Launch Pad, expand Administration, and click User 
Manager. Then do the following:

a In the Role list, select Engineer (System).

b In the Domain list, select the domain of the user you want to 
add.

c In the Domain Users list, select one or more users.

d Click Add. The selected users are added to the Role Users list. 

3 In the Launch Pad, expand Administration, and click License 
Manager. Then do the following:

a Click Tag Server Writeback.

b Select Enabled for ALL tag server nodes.

c Click Save.

4 From a command prompt, type services.msc and press Enter.
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5 Restart the service Wonderware RunTime DB Handler.

6 Reload the Information Server portal page.

Note:  You can also enable write-back for selected nodes instead of for 
all nodes. For more information, see the section Enabling Tag Server 
Writeback in the Wonderware Information Server Administration Guide.

Using InTouch Windows 
After you transform InTouch Windows and publish their displays to 
Information Server, the displays appear with gradient title bars in the 
Information Server as they do in InTouch. 

You need to be aware of a few differences between InTouch Windows 
in WindowViewer and the published displays:

• If you are transforming an InTouch Window calling more than one 
InTouch window with script or animation at the same time, not all 
linked InTouch Windows are transformed. 

• You cannot use multiple InTouch windows of type Replace and 
Overlay at the same time in Information Server. 

• Windows with Overlay window type are transformed as Replace 
window type. 

Inputting Data at Run Time
The visual appearance of the dialog boxes to enter data at run time is 
different than that of the desktop environment.

The following table shows the dialog boxes of various data types you 
use to enter specific data at run time. 

Data Type Run-Time Dialog Box

Boolean
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Analog

String

Data Type Run-Time Dialog Box
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Configuring TableWeaverSet Displays
You can configure published TableWeaverSet displays in the 
Wonderware Information Server portal from any computer with 
Internet Explorer. 

For more information on configuring Table Weaver displays, Queries 
and Content Units, see the Wonderware Information Server 
Administration Guide.

Note:  You can only map public custom properties of the published 
ArchestrA symbol. You cannot map Galaxy references, InTouch 
references or custom properties of embedded symbols within the 
published symbol.

Time

Elapsed Time

Data Type Run-Time Dialog Box
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To configure TableWeaverSet displays

1 Start Internet Explorer and browse to the Information Server, 
such as http://mycompany/Wonderware. The Information 
Server Portal page opens.

2 On the Launch Pad, expand Table Weaver Manager and click 
Displays. The Displays page appears on the right.

3 Click New and in the Display Type list, select ArchestrASymbol. 
The page is populated. 

4 In the Display ID box, type a name for the display.

5 In the Symbol list, select your published TableWeaverSet display. 
The Custom Properties - Data Field Mappings area shows the 
public custom properties of the published symbol. 

6 In the Data Field boxes, type the names of the columns from the 
query result set of the query to the Historian. 

7 When you are done, click Save. 
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Appendix A

Limitations of the ArchestrA
Web Exporter

There are some limitations of the ArchestrA Web Exporter, such as 
unsupported features and features that appear or behave differently 
on the web compared to a desktop environment. 

Unsupported Features
This section lists all features of ArchestrA Symbols and InTouch 
Windows that cannot be transformed by the ArchestrA Web Exporter. 

Unsupported ArchestrA Graphic Elements
The following ArchestrA Graphic elements are not supported by the 
ArchestrA Web Exporter:

• ArchestrA Client Controls, such as the ArchestrA Alarm Control or 
the Trend Control

• Third Party Windows controls

• ActiveX controls

• .NET controls

• Trend Pen
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Unsupported ArchestrA Graphic Animations
The following ArchestrA Graphic animations are not supported by the 
ArchestrA Web Exporter:

• Action Scripts triggered by the center or right mouse button. 

• Point Animation

• Element Style Animation

• Alarm Border Animation

Unsupported ArchchestrA Graphic Configurations
The following ArchestrA Graphic configurations are not supported by 
ArchestrA Web Exporter:

• Element Style

• Symbol Wizard

Unsupported ArchestrA Script Functions
The following ArchestrA script functions are not supported by the 
ArchestrA Web Exporter:

• ActivateApp

• CreateObject

• HideGraphic

• HideSelf

• LogDataChangeEvent

• LogMessage

• SendKeys

• SetBad

• SetGood

• SetInitializing

• SetUncertain

• ShowGraphic

• SignedAlarmAck

• SignedWrite

• WWControl

• WWExecute
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• WWPoke

• WWRequest

Unsupported ArchestrA ShowSymbol Animation 
Configurations

The following features of the ArchestrA ShowSymbol animation are 
not supported:

• Reference as Desktop. As the transformed display is using a web 
browser window, all Desktop references relate to the Client Area 
instead.

• Reference as Desktop X Y. As the transformed display is using a 
web browser window, all Desktop X Y references relate to the 
Client Area instead.

• The Relative to Desktop setting is ignored and relates to the 
Client Area instead.

Unsupported ArchestrA Symbol Shortcut Keys
The following shortcut keys do not work in transformed displays: 

• Function keys F1, F3, F4, F5, F6, F10, F11

• Function key F12 on Internet Explorer 8.0. F12 is supported in 
Internet Explorer 6.0 and 7.0.

• Up arrow, Down arrow, PgUp, PgDn

• Tab, Print, Execute, Separator, Num Lock, Help

• Backspace, End, Home

• ALT key with any of the following keys:

• A, C, D, F, N, P, U, Z

• Arrow keys

• Home, End, +, - 

• CTRL key with any of the following keys:

• A, B, C, D, E, F, H, I, L, N, O, P, R, S, V, W, X

• Left arrow, Right arrow, Enter, Click, Tab, F5

• SHIFT key with any of the following keys:

• Tab, Ctrl + Tab, F10
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If your ArchestrA Symbols or InTouch Windows use any of the keys 
above in key equivalents to trigger scripts, a warning appears in the 
Conversion report. 

Use a supported key combination instead.

Unsupported .NET Functions
You can use .NET types in ArchestrA Symbol scripting to enhance the 
functionality of the symbol. Transformed ArchestrA Symbols use 
Microsoft Silverlight to show and animate ArchestrA Symbols on the 
web. 

However, Microsoft Silverlight only supports a smaller .NET type set 
compared to the .NET Framework type set. The .NET types you use in 
your symbols may not be supported by Microsoft Silverlight. 

If you transform ArchestrA Symbol scripts containing unsupported 
.NET types, the ArchestrA Web Exporter shows warnings in the 
conversion report and the script is not transformed. 

To view supported .NET types

1 On the computer with the installed ArchestrA Web Exporter, open 
the file C:/Program 
Files/ArchestrA/Framework/Bin/aaWXE/Designtime/Silverligh
tDllTypes/AllSLDLLTypes.xml in an appropriate XML Editor. 

2 Use the XML Editor to view supported .NET types or to find .NET 
types. If the .NET is not listed in the file, it is not supported.
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Unsupported InTouch Components
The following list shows the InTouch components that are not 
supported by the ArchestrA Web Exporter: 

• Receipe Manager

• SPC Pro

• SQL Access

• 16 Pen Trend

Note:  If you transform and publish unsupported objects or objects 
that contain unsupported objects (such as Symbol Factory Wizards, 
cells, symbols or SmartSymbols using unsupported objects), the 
published symbol may show unpredictable behavior at run time.

Unsupported InTouch Features
The following list shows the InTouch features that are not supported 
by the ArchestrA Web Exporter:

• InTouch Keyboard as entry method

• Blink Frequency setting 

• Script Timeouts 

• Close button for an InTouch window

Unsupported InTouch Graphics
The following list shows which InTouch Graphics are not supported by 
the ArchestrA Web Exporter:

• ActiveX Controls

• GOT Objects

• Real Time Trend

• Historical Trend

• Historical Trend Wizards
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Unsupported InTouch Touch Action Scripts
The following InTouch Touch Action scripts are not supported:

• On Right Click

• While Right Down

• On Right Up

• On Right Double Click

• On Center Click

• While Center Down

• On Center Up

• On Center Double Click

Unsupported InTouch Script Types
The following InTouch Script Types are not supported:

• Application Script

• Key Script

• Condition Script

• Data Change Script

• QuickFunction Script

Unsupported InTouch QuickScript Functions
The following is a list of all unsupported InTouch QuickScript 
functions. 

If you try to transform InTouch Windows containing the following 
QuickScript functions, a warning is logged to the conversion report.

• Ack

• ActivateApp

• AddPermission

• All Distributed Alarm Object functions. These start with “alm”. 

• AnnotateLayout

• All Alarm Printer functions. These start with “APU”.

• AttemptInvisibleLogon

• ChangePassword

• ChangeWindowColor
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• DialogStringEntry

• DialogValueEntry

• EnableDisableKeys

• All File Access functions. These start with “File”.

• GetAccountStatus

• GetNodeName

• GetWindowName

• Hide

• All Historical Trend functions. These start with “HT”.

• All Information functions. These start with “Info”.

• InTouchVersion

• InvisibleVerifyCredentials

• All IO functions. These start with “IO”.

• IsAnyAsyncFunctionBusy

• IsAssigendRole

• LogMessage

• Logoff

• LogonCurrentUser

• OpenWindowList

• PlaySound

• PostLoginDialog

• PrintHT

• PrintScreen

• All 16 Pen Trend functions. These start with “pt”. 

• QueryGroupMembership

• All Recipe Manager functions. These start with “Recipe”. 

• ReloadWindowViewer

• RestartWindowViewer

• SendKeys

• SetWindowPrinter

• ShowHome
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• All SPC Pro functions. These start with “SPC”. 

• All SQL Access functions. These start with “SQL”. 

• StartApp

• StringCompareEncrypted

• SwitchDisplayLanguage

• All TSE-related functions. These start with “TSE”. UTCDateTime.

• All Windows Control functions accessing the file system:

• wcLoadList

• wcLoadText

• wcSaveList

• wcSaveText

• WindowState

• WWControl

• WWExecute

• WWIsDayLightSaving

• WWMoveWindow

• WWPoke

• WWRequest

Write-back to System Tags and Indirect Tags 
Prevented

For security reasons, you cannot write back directly to System Tags 
and Indirect Tags from published InTouch Windows. 

Features with Limitations and Differences
This section lists all supported features with partial limitations or 
differences in their appearance or behavior compared to a desktop 
environment.
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Logging to the ArchestrA Logger
The LogMessage command is not supported by the ArchestrA Web 
Exporter.

If you try to transform an ArchestrA symbol or InTouch window with a 
script containing a LogMessage command, ArchestrA Web Exporter 
shows a warning in the Information pane. The script is not 
transformed. 

If you need to log messages to the ArchestrA Logger from a published 
display, you can do so by triggering a script on a deployed Automation 
object or in InTouch WindowViewer.

To write to the ArchestrA Logger from the Galaxy

1 Create a Boolean UDA on an Automation Object.

2 Create an OnTrue script on an Automation Object that is triggered 
by the Boolean UDA.

3 In the script body, you can: 

• Use the LogMessage() command to write to the ArchestrA 
Logger.

• Reset the Boolean UDA.

To write to the ArchestrA Logger from InTouch 
WindowViewer

1 In WindowMaker, create a discrete memory tag.

2 Create a Conditional script that is triggered when the discrete 
memory tag becomes true (OnTrue).

3 In the condition script body:

• Use the LogMessage() command to write to the ArchestrA 
Logger.

• Set the discrete memory tag to 0;
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Rotation of Windows Controls
In WindowViewer, if you rotate a group containing a Windows Control, 
the Windows Control outline is rotated and is labeled that it cannot be 
rotated. 

In Information Server, if you rotate a group containing a Windows 
Control, the Windows Control is not rotated with the group and can 
still be used.

This is because of a Microsoft Silverlight limitation.

Adding Items to Windows Controls
If you add an item with the AddItem method to a combobox or listbox 
control in an ArchestrA Symbol, the associated reference is set to the 
new value. 

In the InTouch HMI, if you add an item with the wcAddItem 
QuickScript to a combobox or listbox Wizard, the associated reference 
is unchanged and not written to.

The ArchestrA Web Exporter follows the behavior of InTouch in this 
case, and never writes values back to the associated referenced when 
you add items using the AddItem method or wcAddItem QuickScript.

InTouch SetProperty and GetProperty Functions
The ArchestrA Web Exporter only supports the InTouch SetProperty 
and GetProperty functions in connection with Windows Controls, not 
with any other controls. 

Truncations and Line Wrapping in Windows 
Controls

Windows Controls in the InTouch HMI do not always show the correct 
font size. When the ArchestrA Web Exporter transforms Windows 
Controls, these may appear truncated or the text may be wrapped in 
the Information Server portal.

To work around this problem, increase the size of the Windows 
Controls in the InTouch HMI before transforming.



Features with Limitations and Differences65

Wonderware ArchestrA Web Exporter Guide

Differences in the Calendar Control
Because of limitations in Microsoft Silverlight, the appearance of the 
transformed Calendar control is different than the desktop experience 
of the Calendar control in WindowViewer:

• Different style

• The Fill color area is larger in Information Server than in 
WindowViewer

• Bolded dates do not appear in Information Server 

Differences in InTouch Window Types
Windows with Overlay Window Type cannot be shown together in the 
portal at the same time. If you call an Overlay Window with a Show 
Window animation or script, it is converted the same way as a Replace 
Window. 

If you configure an InTouch Window with script or Show Window 
animation to open more than one Windows of any type at the same 
time, in Information Server only the last Window referenced by script 
or last Window in the list is opened. 

Show Symbol/Window Name Limitation
If you are transforming an InTouch Window with a Show Window 
animation and an embedded ArchestrA Symbol that uses the Show 
Symbol animation, both of which are calling a Window and an 
ArchestrA Symbol with the same name, the ArchestrA Web Exporter 
does not transform this correctly because of the name conflict.

Make sure you give InTouch Windows and ArchestrA Symbol unique 
names. 

Duplicate InTouch Windows Controls Naming
You cannot transform InTouch Windows containing duplicate 
Windows Controls name, for example an InTouch Window containing 
two textboxes with the same name “TextBox_1”. The ArchestrA Web 
Exporter shows an error if you try to do so.
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Differences in FOR NEXT Loop Execution
ArchestrA scripting supports automatic backwards execution of a FOR 
NEXT loop if the start value is larger than the end value. For example: 

FOR i = 10 to 1

The loop is automatically executed so that the variable i progresses 
from 10, 9, 8, ... down to 1.

In the InTouch HMI, the same loop is not executed at all. 

The ArchestrA Web Exporter follows the ArchestrA scripting approach 
and automatically assumes the STEP value is -1 if the start value of a 
loop is larger than the end value.

This applies also for transformed scripts from InTouch. Published 
InTouch Windows containing FOR NEXT loops with their start value 
larger than their end value are executed as if the STEP value is -1. 

Differences in the StringFromTime Function 
Result

The StringFromTime function returns a different result in ArchestrA 
scripting compared to the StringFromTime QuickScript used in the 
InTouch HMI.

The ArchestrA Web Exporter follows the functionality of the 
ArchestrA implementation of the StringFromTime function.

Formatting for Analog User Input and Value 
Display

The configuration in the formatting group of the Analog User Input 
and Value Display animation link is ignored, and the run time analog 
data is displayed in the text string format.
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Appendix B

Design Recommendations

Read this section for recommendations on designing ArchestrA 
Symbols and InTouch Windows you want to publish to the web. 

These recommendations apply depending on your target web user. The 
following are limiting factors:

• Connection speed: Dial-up, Internet, or local area network?

• Number of concurrent users

• Performance of user’s computer

Limit the Complexity of the Symbol or Window
Limit the complexity of the Symbol or Window so that it can show in 
the end users browser quickly. 

The complexity of a Symbol or Window contributes to the file size that 
needs to be copied to the user's computer for visualization. 

If the Symbol or Window contains non-animated complex elements, 
consider using a bitmap instead. 

To create a bitmap of a complex Symbol or Window

1 Open the ArchestrA Symbol or InTouch Window in 
WindowViewer.

2 Hold the ALT key and press Print Screen.

3 Open the Windows Paint program.

4 On the Edit menu, click Paste.

5 Crop the graphic to include just the window you want.
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6 Save the bitmap as a file.

7 Import the bitmap into the ArchestrA Symbol Editor or InTouch 
Window. For more information, see the Creating and Managing 
ArchestrA Graphics User’s Guide or the InTouch HMI 
Visualization Guide.

Avoid Complex Elements and Gradients
The ArchestrA Symbol Editor supports many graphical elements that 
require more processing power than simple elements such as the 
rectangle. 

If you use a sufficient high number of these complex elements in your 
Symbol, the performance of the Symbol on the web may degrade.

To improve performance, avoid using complex elements, such as: 

• Curves 

• Chords

• Pies

• Polygons

• Polylines

• Paths

Instead consider using simpler elements, such as rectangles and lines.

Also avoid using groups whenever possible. As groups can be 
animated, this adds to the complexity of the symbol. 

Consider ungrouping elements as long as this does not cause any 
functional issue, such as element name referencing.

Also, consider using solid colors instead of gradients in your solid 
elements. Solid colors can be rendered faster than gradients, as 
gradients need to be calculated. 

Avoid Animations on Groups
Animations on groups, although supported, can degrade the 
performance of the Symbol on the web. Avoid using animations on 
groups if you see degraded performance.
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Avoid Embedding of Symbols in Symbols
Whenever possible, avoid multiple levels of embedding of Symbols 
within Symbols. Each time a Symbol is embeddded in another Symbol, 
data is exchanged between the Symbols at run time, which takes 
additional processing time. 

Consider transforming an embedded symbol to a group by 
right-clicking on the embedded symbol, pointing to Embedded Symbol 
and clicking Convert to Group. If possible, you can ungroup the 
elements in the group to achieve better performance.

Merge Multiple Windows to One Window
If you want to publish an InTouch application with multiple 
concurrently showing Windows to the web, merge the content of the 
Windows to one single Window. 

Wonderware Information Server does not support showing multiple 
Windows at the same time in the ArchestrA Graphics feature.

An example is the InTouch Reactor Demo which uses multiple 
Windows with different purposes at the same time:

• Process Visualization

• Trending

• Visualization Control
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